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Используйте оригинальное содержание при выполнении каждого задания, а не содержание, включенное в аудиторную работу для демонстрации навыков и формирования общего представления о предмете. Постарайтесь сдавать готовые задания
(или присылать мне на email: inal@nosu.ru), до перехода к новой теме.

Проектирование сайта
Перед тем, как вы начнете проектировать web-сайт на компьютере, для начала необходимо знать, что именно, почему и для кого вы хотите создать. А так же, какие возможности он должен предоставлять для потенциального посетителя. Поэтому работа с вашим клиентом над проектированием web-сайта – это самый решающий первый шаг.
По пунктам распишите для себя на бумаге следующие моменты:
1. Идентификация вашего конечного проекта (т.е., кто ваш клиент и какой сайт вы создаете?)

2. Анализ целевой аудитории
a. Послание: информация, которой вы хотите поделиться или прорекламировать
b. Аудитория: определенный читатель/потребитель вашей информации/продукции. Что уже известно данной аудитории? В какой дополнительной информации они нуждаются?
c. Цель: Какие действий вы хотите, чтобы предпринял потенциальный читатель/потребитель после посещения вашего ресурса?


3. Перечень разделов вашего сайта (например:)

a. Домашняя страница
b. Продукция
c. Поддержка
d. Контактная информация
e. Заказ


4. Структура сайта или логический дизайн: блок-схема, иллюстрирующая организацию вашего сайта (нарисованная от руки, она будет иметь одну, из нижеприведенных, структуру, но с вашими основными подразделами)

a. Сайт произвольного доступа: возможность перейти на любую страницу с любой другой страницы сайта
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b. Линейный сайт: возможность последовательно (линейного) перемещения по сайту по принципу «назад/вперед»
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c. Сайт с иерархической структурой: ограниченный доступ к страницам схожего содержания (вспомните организационную диаграмму)
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d. Смешанный: комбинации любой из вышеперечисленных структур
5. Контент-анализ (в виде плана; максимально детализируйте его для вашего заказчика, чтобы упростить себе задачу в ходе проектирования!!!) 

a. Страниц будущего сайта (используйте нумерацию типа A, B, C и т.д. или I, II, III, и т.д.)

b. Текстового и графического содержания каждой страницы (добавляйте подпункты плана). В итоге вы должны получить нечто подобное:

***********************

A. Домашняя страница
1. Текст
a. Приветствие
b. Контактная информация
c. Информация об авторских правах
2. Графические объекты
a. Панель навигации
(1) Домой
(2) Продукты
(3) Заказ
b. Логотип компании
c. Изображение счастливого потребителя
B. Продукция
1. Текст
a. Таблица отражающая наименования продуктов, их описание, цены
b. Общая гарантийная информация
2. Графические элементы
a. Панель навигации (см. выше)

b. Логотип компании
c. Изображения продукции

C. (Проделайте то же самое для оставшихся страниц, не указанных здесь из экономии места, чтобы подготовить полный план контент-анализа)

1. Текст
a. (определите, какая порция текстовой информации ляжет в основу тех или иных страниц сайта)

2. Графические элементы
a. Панель навигации (см. выше)

b. (определите, какие иллюстрации лягут в основу тех или иных страниц сайта)

***********************

6. Интерактивный дизайн (раскадровка: небольшие эскизы всех страниц – или, хотя бы, каждого основного подраздела). Наглядно проиллюстрируйте (зарисовав, или сделав типовые наброски):


a. Организацию графических, текстовых и других элементов на страницах (выдерживайте логическую последовательность и композиционную структуру графических элементов, навигационных ссылок и текста, согласно устоявшимся традициям и привычкам пользователей и потребителей)


b. Навигацию (Как зритель перемещается по страницам в рамках сайта? Сохраняйте полное соотношение с предварительно подготовленной блок-схемой будущего ресурса).


c. Комплексность (Как пользователь будет взаимодействовать с сайтом? Какую цель, упомянутую выше в пункте 2c, вы определили? Как пользователь достигнет этой цели?)


7. Презентационный дизайн (Примечание: присвойте уникальные имена шестнадцатеричному цветовому коду и текстовому шрифту – именно на этом будет основан выбор дальнейшего графического материала и общего стиля сайта, который необходимо обязательно продумать заранее) 


a. Цветовая схема: цвета фонов, текста, ссылок и т.д. Сохраните ли вы общую цветовую гамму для всего проекта или установите индивидуальную для каждого тематического подраздела? Будете ли вы использовать цвет фона или фоновый рисунок?


b. Стили: определите шрифт, цвет, размер, стиль (например, курсив, полужирный, подчеркивание) для следующих текстовых элементов по мере их использования в содержании сайта:

i. Главный заголовок:

ii. Заголовки для групп продуктов:

iii. Основной текст:

iv. Описание продукции:

v. Цена:

vi. Гиперссылки:

vii. Подписи к картинкам:

c. Графические объекты: источники получения графического материала (например, Internet, контактное лицо, собственные материалы, отснятые на цифровую камеру и т.д.) Лучше всего предварительно рассчитать все это перед тем, как вы приступите к работе!

ДЗ 1: Организация вашего сайта
Следующим немаловажным шагом в разработке эффективного web-ресурса является организация структуры будущего сайта. Причина, по которой необходимо сделать это корректно именно сейчас, заключается в том, что все ваши гиперссылки и графические элементы основаны на «путях». Путь – это «адрес», по которому расположен специальный файл внутри специальной папки. Следовательно, для начала, должна быть организована структура папок и подпапок, чтобы лишь затем распределить все графические объекты и web-страницы по соответствующим директориям. Это необходимо сделать до того, как на сайт-проекте будет помещен весь иллюстративный материал и будут настроены все гиперссылки. Не смотря на то, что сайт-менеджер программы Dreamweaver дает возможность перемещать файлы и потом, лучше заведомо освободить себя от необходимости заменять графические объекты и переназначать разорванные ссылки.

Примечание: выработайте привычку сохранять ваши страницы до того, как вы разместили на них графические объекты, во избежание появления разорванных ссылок на объект.

A.
Откройте Dreamweaver
A. Определите новый сайт для вашего финального проекта
1. Дайте ему название
2. Создайте корневую папку (к примеру, с названием вашего сайта) на вашем диске 
Примечание: все текстовые и графические файлы должны быть записаны в эту папку, чтобы ваши ссылки работали корректно. Сделайте это внимательно, во избежание серьезных проблем впоследствии
3. Создайте внутри корневого каталога подпапки с именами: “Graphics”, “Web” и “Practice”
4. Создайте домашнюю страницу index.htm; напечатайте свое имя в любом месте страницы; запишите ее в корневую папку, но вне папки “Web” и Dreamweaver создаст для вас вашу карту!

B. Откройте FTP

1. Скопируйте, пользуясь сервисом FTP, содержимое корневой папки вашего финального проекта на сервер, используя свою персональную учетную запись (файловая структура учетной записи должна полностью совпадать с файловой структурой вашего дискового носителя, на котором размещены ваши исходные файлы!)


2. Составные части вашего URL: http://cc.usu.edu/~jpratt/5450/index.htm
a. http://
Файловый протокол и разделители
b. cc.usu.edu
Имя домена (т.е. сервера, размещающего ваш сайт)
c. ~jpratt 
Учетная запись пользователя (для USU необходимо напечатать знак тильда (~) перед вводом имени, которое отражено в учетной записи пользователя)
d. 5450
Имя вашего корневого каталога 
Примечание: Таким будет имя web-сайта вашего клиента!
e. default.html 
Имя вашего стартового файла. (Уточните у вашего поставщик услуг Internet!). К примеру, серверы PCU.net автоматически отображают страницы с названиями default.html, index.html и index.htm. Что дает возможность вводить URL в адресную строку только до указания корневого каталога: 5450/
Учтите, что каждый компонент URL отделяется от другого левой косой чертой (/). Обратите также внимание на то, что нигде в URL не фигурирует www. Это может разниться от сервера к серверу.

Теперь, когда ваши папки находятся на сервере, все, что необходимо будет делать всегда – это, переписывать файлы по мере их обновления в приготовленные каталоги.

Подумайте:
1. Многие профессиональные web-разработчики создают каркасную структуру всего сайта (другими словами, его скелет), до его полного информационного наполнения. В чем преимущество такого подхода? Есть ли у него свои недостатки?
2. Перечислите определяющие элементы структуры сайта (т.е., получив от клиента информацию о содержании будущего web-сайта, как бы вы организовали его структуру)?
ДЗ 2: Вставка комментариев в HTML-код. Добавление гиперссылок у других элементов
Модификация свойств страницы
Используйте диалоговое окно Page Properties (Свойства страницы), чтобы применить следующие свойства к вашей странице:

· page title – «заголовок страницы» (первыми должны идти однозначно определяемые слова)

· background color and/or image – «цвет фона и/или фоновый рисунок» (если режима отображения графических объектов отключен пользователем, то будет показан только цветовой фон)

· text and link colors – «цвет текста и гиперссылки» (используйте цвета контрастные фону и соответствующие web-стандартам)

· top/left margin widths – «верхний/левый отступ» (во избежание появления белых границ вокруг страниц, спроектированных в виде графических объектов, к примеру, в Fireworks, и выкрашенных в другой цвет)
Вставка комментариев
Комментарии, вставленные в ваш HTML-код, напоминают и инструктируют вас (или последующего разработчика) о том, как сохранить ваше детище в первозданном виде. Пожалуйста, документируйте то, что делайте!!! Вам еще не раз придется сказать себе за это, спасибо!
A. Добавьте комментарии в ваш HTML-код
1. Щелкните мышью на значке Comments (Комментарий) на Common toolbar (Общей панели инструментов)
2. Впечатайте ваш комментарий
или
3. Перейдите в режим редактирования HTML-кода
4. Введите следующие символы: <!-- Здесь впечатайте ваш комментарий -->

5. Примечание: Наличие пробела между текстом и двумя дефисами не обязательно.

Примечание: Следите за тем, чтобы оставлять для себя заметки (т.е. комментарии) в тексте HTML-кода, чтобы всегда помнить, что вы уже сделали: вы оцените свой труд, особенно тогда, когда, к примеру, через полгода вздумайте обновить информацию на сайте! Указывайте также ваше имя и адрес электронной почты, чтобы следующий web-дизайнер, дополняющий или корректирующий этот сайт мог связаться с вами.
B. Датируйте каждую страницу (или, по крайней мере, домашнюю страницу), чтобы посетители видели дату последнего обновления – сохраняйте у посетителей желание прийти к вам еще раз, постоянно поддерживая информацию на сайте обновленной
1. Щелкните мышью на значке Date (Дата) на Common toolbar (Общей панели инструментов)
2. Выберите формат отображения даты
3. Наберите вводный текст на странице
Использование различных гиперссылок
Простые ролловеры и навигационную панель с ссылкам на другие страницы сайта вы научитесь создавать в Fireworks. Здесь же пока представлен ряд других типов ссылок, которые могут оказаться очень полезными.
A. Создайте базовые гиперссылки
1. Из текста на любую другую страницу сайта; используйте заголовок ссылки
2. С картинки на любую другую страницу сайта; используйте тег ALT для создания всплывающей подсказки


B. Создайте ссылку на адрес электронной почты 

1. Если вы хотите сделать гиперссылку с графического объекта на адрес электронной почты, то впечатайте код e-mail ссылки в Properties inspector (инспектор Свойства). Помните, что использование пробелов допустимо только при указании темы (subject) письма.
2. При использовании значка Email Link (Вставка ссылки на e-mail) программа, по умолчанию, вставляет выделенный предварительно фрагмент текста в поле “Text of Link”. При необходимости вы можете его заменить, что отразиться на тексте страницы. 

3. Не забывайте правильно маркировать subject (тему) письма во всех email-ссылках.


C. Создайте Named Anchor (Именной якорь) и ссылку на него
1. Создайте именной якорь в начале вашей странице
2. Создайте на несколько экранных страниц ниже гиперссылку на этот именной якорь, предварительно проставив несколько абзацев

D. Создайте внешнюю гиперссылку (не забудьте указать http://, а не то ваша ссылка не будет работать).
Задавайте Titles (Заголовки) для гиперссылок, для отражения их на всплывающих подсказках.


E. Создайте карту рисунка, по меньшей мере, с тремя участками 
1. Используйте разные участки (Rectangle, Circle and Polygon Hotspot Tools) для каждой ссылки
2. Назначьте всплывающую подсказку для каждого участка
Добавление различных элементов
Вы уже немного экспериментировали с основными элементами любой web-страницы: масштабной линейкой, текстом, слоями, таблицами, графическими объектами. Теперь поразмышляйте над тем, как вы можете управлять этими элементами, чтобы представить свой сайт максимально презентабельно с точки зрения содержания.
Создайте страницу, содержащую следующие компоненты:

A. Горизонтальный разделитель (Insert > HTML > Horizontal Rule)
1. Задайте ширину и высоту
2. Задайте, если желайте, цвет разделителя <hr color=red>


B. Списки (Text > List > …)
1. И нумерованные, и маркированные (создайте два списка любого содержания)
2. Поэкспериментируйте с отступом (Text > Indent/Outdent)
3. Поэкспериментируйте с элементами подпункта List (Список) меню Text (Текст)
4. Обратите внимание, что модифицируемые компоненты списка в Dreamweaver MX отражаются в Properties inspector (инспекторе: Свойства).


C. Слои (Insert > Layout objects > Layer)
1. Поэкспериментируйте с различными вариантами «переноса текста в слое» через опцию Overflow инспектора: Свойства.
2. Назначьте одному из слоев цвет фона
3. Другому, назначьте произвольный фоновый рисунок (учтите, что это не то же самое, что вставить рисунок на страницу!)

D. Таблицы
1. Установите цвет границы (поэкспериментируйте также с bordercolordark= и bordercolorlight=)
2. Измените цвет фона хотя бы одной ячейки
3. Объедините и разбейте некоторые ячейки
4. Выберите подходящую ширину (в процентах или пикселах, на ваше усмотрение) 
(В чем, по-вашему, заключается разница?)

5. Установите выравнивание по горизонтали и вертикали для текста в ячейках
E. Два графических объекта (Примечание: ограничьте использование графических объектов на текстовом сайте только логотипом компании, в крайнем случае, еще одного дополнительного элемента графики).
1. Убедитесь в том, что все рисунки имеют альтернативную всплывающую текстовую подсказку.
2. Установите границу для одного из рисунков
3. Используйте таблицу 1х1 с рамкой, для другого рисунка. Что вам нравится больше?

4. Выровняйте графические объекты либо с помощью значков Alignment (Выравнивание) в Properties inspector (инспекторе: Свойства), либо поместите рисунок в слой и переместите его в любое место страницы


Пришлите мне по email ссылки на страницу(ы), демонстрирующие ваше превосходное владения всеми перечисленными выше навыками.

Подумайте: Ваш клиент хочет иметь красочный графический сайт, но потенциальный потребитель продукции вашего клиента испытывает некоторые технические затруднения в использовании широких возможностей Интернет, в частности, в загрузке большого объема графических материалов. Какие дизайнерские находки помогли бы вам удовлетворить запросы, как вашего клиента, так и конечного пользователя?

ДЗ 3: Создание форм
Использование форм – замечательный способ для получения информации от посетителей вашего web-сайта. Не смотря на то, что проблемы обеспечения безопасности передачи данных выходят далеко за рамки этого курса, вы можете создать интерфейс, который впоследствии может быть привязан к базе данных, обеспечивающей надежную защиту при передаче информации.
Примечание 1: Для начала, воспользуйтесь значком Form (Форма) панели инструментов Forms (Формы) или пунктом меню Insert > Forms > Form (Вставка > Формы > Форма). На странице вы увидите прямоугольную рамку с красной пунктирной границей. Это признак того, что программа вставила в HTML-код открывающий и закрывающий теги <form></form>.

Примечание 2: Для правильной компоновки элементов формы, лучше всего, предварительно, вставить внутрь заготовленной формы, таблицу. Затем, в нужных ячейках, поместить те или иные элементы формы. Вам придется объединять или разбить некоторые ячейки, чтобы произвести корректное выравнивание.
Примечание 3: Введите уникальное имя для каждого элемента формы так, чтобы оно было ясным и однозначным как для вас, так и для вашего клиента.
Примечание 4: Обычно, текст описания полей (fields) формы размещается слева, в то время как текст описания для переключателя (radio button) или флаговой кнопки (check box) размещается справа от этих элементов.
A. Создание формы
1. Переключитесь на панель инструментов Forms (Формы)
2. Вставьте тег формы, нажав на значок Form (Форма) (Примечание: чтобы видеть форму, выберите View > Visual Aids > Invisible Elements (Просмотр > Визуальные средства > Невидимые элементы); все поля должны быть внутри тега формы – красной пунктирной линии.)


B. Вставка объекта Text Field (Текстовое поле)
1. Вставьте текстовое поле; дайте имя этому полю
2. Вставьте три различных доступных варианта текстового поля.

3. Установите тип (Type) текстового поля и его соответсвующих свойств через Properties inspector (инспектор: Свойства)


C. Вставка списков и ниспадающих меню List/Menu (Список/Меню)
1. Вставьте список или меню
2. Установите значение (value) для списка или меню
3. Для списков, установите видимую высоту (height) списка и возможность выбора только одного или сразу нескольких пунктов (Selections: Allow multiple)
4. Выберите один из пунктов, который вы хотите отражать по умолчанию 


D. Вставка Jump Menu (Меню перехода)
1. Вставьте меню перехода
2. Введите имя первого пункта меню перехода
3. Нажмите кнопку Browse (Обзор) для выбора .html-файла, на который будет осуществляться переход
4. Выберите либо опцию: Вставить кнопку «Перейти» (Options: Insert ‘GO’ button), либо создайте пункт типа: «Выберите из списка» с ссылкой на текущую страницу, т.е. на саму себя
5. Выберите один из пунктов, который вы хотите отражать по умолчанию


E. Вставка Radio Button (Переключатель)
1. Вставьте один или несколько переключателей
2. Присвойте уникальное имя каждой группе переключателей


F. Вставка кнопок Submit (Отправить) и Reset (Сброс)
1. Вставьте кнопку Submit/Reset (Отправить/Сброс)
2. Введите текст (label), который вы хотите отобразить на кнопке
3. Выберите необходимое действие, т.е., либо submit (отправить), либо reset (сброс)


G. Отправка заполненной формы на e-mail
1. Вставьте кнопку Submit (Отправить)
2. Перейдите в режим редактирования html-кода
3. Введите следующий код внутри открывающего тега <form>:
<form name="form1" enctype=text/plain method="post" action="mailto:inal@nosu.ru?subject=Website Form"> (Введите свой собственный адрес e-mail и тему (subject) сообщения).
Подумайте: 
1. Какой объем персональной информации вы хотите предоставить через Интернет? Есть ли способ, посредством которого вы могли бы сформировать online-опросник, чтобы получить максимально полезную персональную информацию? Какие другие маркетинговые методы вы можете использовать в сочетании с online-опросом, чтобы необходимую для вас информацию?

2. На сколько вопросов пожелают ответить конечные пользователи? Какие альтернативные варианты получения дополнительной информации вы можете предложить?
ДЗ 4: Сайт, основанный на формах.
Библиотека. Стили.
Собирайтесь ли вы использовать набор фреймов? Собирайтесь ли вы использовать шаблоны? Собираетесь ли вы использовать набор фреймов и шаблоны? Собирайтесь ли вы строить каждую страницу в отдельности? Обдумайте блок-схему, которую вы создали предварительно. Какой подход к созданию вашего web-сайта максимально облегчил бы решение задач на основе этой блок схемы?
После того, как вы и ваш клиент определились с методом реализации web-проекта, постарайтесь придерживаться его на протяжении разработки остальных страниц.
A. Создание набора фреймов (frameset)
1. Откройте новое окно в программе Dreamweaver
2. Выберите Category: Frameset (Категория: Набор фреймов), либо создайте свой собственный
3. Сохраните набор фреймов (Примечание: убедитесь, что границы фреймов выделены)

4. Запишите все фреймы (frame) в наборе
или
5. Если ранее вы создавали страницы, то поместите ваш курсор в область фрейма и откройте в ней соответствующую страницу: File > Open in Frame (Файл > Открыть во фрейме)
6. Примечание: Перед тем, как, пользуясь сервисом FTP, скопировать ваш сайт на сервер, сохраните набор фреймов с отображаемыми страницами, которые будут продемонстрированы вашему зрителю первыми (например, Домашняя страница, Панель навигации или Баннер).

B. Редактирование страниц для последующего использования в наборе фреймов
1. Создайте, сохраните и закройте разные страницы для вашего сайта, не наполняя их никаким содержанием
2. Откройте ваш набор фреймов
3. Поместите курсор в область фрейма и откройте соответствующую страницу для редактирования
4. Добавьте информацию на страницу
5. Сохраните все фреймы
6. Откройте во фрейм-областях страницы, которые, по-вашему, зритель должен увидеть первыми
7. Сохраните все фреймы


C. Навигация в рамках набора фреймов
1. Введите простые текстовые метки, по крайней мере, на трех различных страницах
2. Назначьте контрастные цвета для гиперссылок навигационной панели
3. Свяжите текстовые метки с различными страницами вашего сайта (убедитесь, что внутри каждой страницы вы где-нибудь впечатали ее имя, чтобы упростить себе задачу тестирования гиперссылок на корректность!)

4. Для каждой ссылки установите Target: mainFrame (Цель: Главный фрейм)


D. Использование элементов Library (Библиотека)
1. Вставьте в Library (Библиотеку) элемент (т.е. объект), который вы хотели бы отобразить на нескольких страницах (например, логотип или информацию об авторских правах)

2. Добавьте его из библиотеки на 3-4 страницы вашего сайта, основанного на фреймах
3. Обновите элемент Library и проверьте внесенные изменения
Примечание: Dreamweaver автоматически создает папку Library, как только вы добавите новый элемент в библиотеку. Не перемещайте эту папку; пусть она находится внутри корневой папки. Файлы с расширением .lbi также постарайтесь оставить нетронутыми. Скопируйте папку на сервер посредством FTP.


E. Использование стилей (подыщите для вашего дизайн-документа подходящий стиль)

1. Создайте стиль близкий к тому, что вы определили для себя, проектируя ваш сайт еще на бумаге
2. Подберите заранее задуманную цветовую гамму и форматирование
3. Откройте уже существующую страницу и прикрепите к ней таблицу стилей, созданную только что
4. На свое усмотрение: Поэкспериментируйте со стилем фона (создайте, к примеру, графический бордюр вдоль одного из краев страницы)
ДЗ 5: Сайт, основанный на шаблоне
A. Сохраните новое окно как шаблон
1. Примечание: Вы можете использовать множество шаблонов в рамках одного сайта, так что постарайтесь присваивать им описательные имена
2. Примечание: Dreamweaver автоматически создает папку Templates (Шаблоны), как только вы сохраняйте любую страницу как шаблон. Не перемещайте эту папку; пусть она находится внутри корневой папки. Файлы с расширением .dwt также постарайтесь оставить нетронутыми. Скопируйте папку на сервер посредством FTP.


B. Примените к шаблону различные элементы, которые бы вы хотели отразить на каждой странице, основанной на шаблоне
1. Цвет фона или фоновый рисунок; цвет текста
2. Таблица с некоторыми ячейками, помеченными как область редактирования (editable region) (или сделайте редактируемыми почти все области страницы, жестко закрепив только 2-3 раздела) Insert > Template Objects > Editable Region
3. Кнопки или ссылки навигации
a. Введите имена страниц, которые вы еще не создали
или
b. Сделайте ссылки на, созданные в ходе проектирования каркаса сайта (скелета), страницы
4. Другие графические объекты (например, логотип компании или торговую текстовую марку)
5. Слои (помните, что если вы используйте слои, то вам необходимо использовать фиксированный  размер шрифта)
a. Создайте любое количество слоев на каждой странице
b. Переведите параметр Visibility (Видимость) в режим Hidden (Скрытый)
c. Сделайте их редактируемыми
C. Создайте страницы, основанные на шаблоне; примените шаблон к имеющимся стираницам
1. Создайте новую страницу, основанную на шаблоне; сохраните страницы согласно именам файлов, которые вы указали в ссылках
или
2. Или откройте существующую страницу, для которой вы создали ссылку в шаблоне; примените шаблон к этой странице; выделите ранее созданную область редактирования, чтобы разместить там текст, который бы вы хотели иметь на странице
3. По необходимости, сделайте слои видимыми и наполните их содержанием
D. На свое усмотрение: Вернитесь в режим редактирования шаблона и внесите изменения в область редактирования. Внесите какое-либо другое изменение в не редактируемую область. Сохраните шаблон и обновите страницы, основанные на шаблоне. Что именно было обновлено на страницах web-сайта? Создайте новую страницу, основанную на шаблоне. Какие изменения произошли? Почему?
ДЗ 6: Использование шаблонов во фреймах
Шаблоны могут быть, и используются внутри набора фреймов. Несомненно - это средство, экономящее время, потому что, достаточно однажды назначить цветовую палитру, фоновый рисунок, стиль и т.д., как вы можете использовать их огромное количество раз.
A. Создайте и сохраните другой шаблон, но НЕ включайте в него главные навигационные ссылки (либо вы можете удалить основные кнопки навигации с имеющегося у вас шаблона и сохранить его под другим именем)
B. Создайте и сохраните набор фреймов
1. Либо сохраните страницы во фреймах, либо откройте существующие во фрейм-областях
2. Создайте ссылки хотя бы на 2-3 страницы; установите параметр Target: mainframe (Цель: Главный фрейм)
C. Примените второй шаблон к главным страницам (т.е. к страницам, на которые вы ссылаетесь); убедитесь, что каждая страница имеет описательное имя для того, чтобы вы могли проверить правильность работы гиперссылок
Примечание: Имейте в виду, что вы будете создавать дубликаты страниц: один набор с и другой без навигационной панели. Также, нужно понимать, что страницы, созданные на основе шаблона для использования в рамках набора фреймов будет отличаться от страниц, которые вы создавали «поштучно» для предыдущего фрейм-сайта.
Подумайте: Можете ли вы объяснить следующие 4 подхода в области разработки web-проектов, определить дизайнерские решения, которые стоят за каждым из них и рекомендовать лучший вариант именно для вашего клиентского сайта:
· Индивидуально, независимо друг от друга, созданные страницы (с или без использования CSS)

· Сайт, основанный на фреймах

· Сайт, основанный на шаблонах

· Сайт, с использование шаблонов в рамках набора фреймов
ДЗ 7: Работа со сценариями (Behaviors) 
в Dreamweaver
Behaviors (Сценарии) – инструмент, применяемый к страницам, графическим объектам и гипертексту. Если ваш текст не является элементом гиперсвязи, то всего лишь добавьте символ пробела или # в поле Link (Ссылка). Самостоятельно также познакомьтесь с другими сценариями, не описанными в этом разделе. Сценарии могут запускаться от различных действий мыши: наведение, удерживание, одинарный щелчок и т.д. 
Примечание: Вы можете получить доступ к еще большему количеству различных действий и событий, если переключитесь на поддержку возможностей браузера версии 5.0 и выше.
Модификация сценариев
A. Добавьте сценарий на страницу
1. Кликните мышью в любом месте рабочей части страницы (либо выделите тег <body> в строке состояния)

2. Перейдите к панели Behaviors (Сценарии)
3. Выберите любой из нижеприведенных сценариев. Dreamweaver автоматически запустит этот сценарий при загрузке страницы
a. Go to URL – «Перейти на URL» (этим действием вы можете воспользоваться, если захотите автоматически перенаправить пользователя с одного сервера на другой)

b. Play Sound – «Воспроизвести звук» 
На ваше усмотрение: как долго будет воспроизводиться звуковой элемент?
c. Set Text of Status Bar – «Установить текст строки состояния»


B. Примените сценарий к рисунку
1. Open Browser Window – «Открыть окно браузера» (особенно полезно для тех, кто собирается использовать иконки для больших рисунков!)

2. Рисунок для мультипликационной перестановки (multiple-swap-image behavior)
a. Создайте все картинки, используемые для перестановки; убедитесь, что они одного размера
b. Вставьте картинки и присвойте каждой из них внутренние имена
c. Выделите рисунок, на который пользователь должен навести мышь, чтобы поменять его местами с любым другим рисунком страницы
d. Выберите опцию Swap Image (Переставить рисунок) из ниспадающего меню Add behavior (Добавить сценарий) панели Behaviors (Сценарии)
e. Выберите файл рисунка перестановки для каждого наименования в списке
C. Примените сценарий к гипертексту

1. Popup Message – «Появляющееся сообщение»

D. Загрузите и примените специальный сценарий
1. Загрузите и установите бесплатную «корзину для покупок» (shopping cart) PayPal; введите наименование товаров/услуг продаваемых через PayPal
2. Загрузите и установите любой сценарий (на ваш выбор) с официального сайта Macromedia; вставьте его, по крайней мере, на одну страницу. (Сообщите мне, на какую именно страницу была осуществлена вставка!)


E. На ваше усмотрение: Поэкспериментируйте с различными запускаемыми действиями: кликните в поле Event/Action (Событие/Действие) панели Bahaviors (Сценарии)
Примечание: Помимо micromedia.com, сценарии можно также скачать с kaosweaver.com и webassist.com
Подумайте: На сегодняшний день через Интернет для скачивания доступно огромное количество сценариев так, что вы можете быстро и легко оснастить свой клиентский web-сайт множеством различных спецэффектов. Каков определяющий теоретический принцип для выбора типа и качества сценария?

Проверка ДЗ 1-7. Экзамен по Dreamweaver.
Экзамен – это открытая книга или записи, 
но не открытые архивные файлы или друг!
Критерии оценки текстового сайта
Оптимизация и вставка графических объектов в Fireworks
A. Загрузка графических объектов посредством Интернет
1. Запустите Интернет-браузер
2. Загрузите с Интернета рисунок для фона (откройте рисунок в Fireworks, чтобы увидеть его реальный размер)

3. Загрузите обычный графический объект (кнопку, логотип, рисунок – на ваш выбор – главное, чтобы он соответствовал содержанию!) с Интернета
B. Сканирование графических объектов (рекомендуется сканировать графический материал большего размера и разрешения, чем он будет использоваться уже на сайте)

1. Отсканируйте полноцветное графическое изображение; обратите внимание на физические размеры
2. Выберите соответствующие разрешение (следите за размером файла!) и графический формат (как правило TIF или GIF)

3. Откройте ваши графические объекты в Fireworks
4. Оптимизируйте их под Web
5. Экспортируйте их


C. Загрузка изображений с цифровой камеры
1. Перенесите фотографии с камеры на жесткий диск
2. Откройте и оптимизируйте их
3. Экспортируйте


D. Оптимизация графических объектов
1. Обращайте внимание на размеры файлов, которые предлагают графические форматы JPEG и GIF
2. Обращайте внимание на параметры настроек, доступных для форматов JPEG и GIF


E. Экспорт графических объектов
1. Было бы неплохо экспортировать объекты больших размеров в объекты двух видов: с низким и высоким разрешением
2. Учтите, что прозрачный фон рисунка доступен только для GIF-файлов
Примечание: Используйте File > Import > Twain Acquire в Fireworks, чтобы автоматически передать отсканированный рисунок в программу.
Создание фонов
Чтобы позднее сэкономить больше времени, вам понадобится собрать воедино некоторые образцы страниц, отображающих различный фон, кнопки, шрифты и цвета. Позвольте вашему клиенту определиться, каким он (или она) видят и ощущают свой будущий сайт, основываясь на предложенных образцах. Как только решение об окончательном варианте будет принято, вы можете приступать к конструированию страниц.

Общий стиль графического сайта вы создадите в Fireworks, экспортируйте его как html-файл с рисунками, откройте его в Dreamweaver и добавите текстовое содержание. Это намного эффективней, потому что вы точно знаете, какого размера создавать каждый элемент страницы.
Для стандартных сайтов вы также можете использовать Fireworks, чтобы создать фон по образцам или линейный фон (swatch or linear backgrounds), который вы могли бы затем вставить в Dreamweaver как фоновый рисунок. Прежде чем выбрать между этими двумя вариантами, вы должны предположительно знать, какое среднее разрешение экрана использует ваш конечный пользователь и лишь соответственно этому создать фоновый рисунок (не обязательно на основе фоновых образцов).

Другой вариант – создать фоновый образец в Fireworks и применить его как верхний, левый или нижней баннер в Dreamweaver, используя его как CSS-стиль.

Описанные выше примеры смотрите на сайте: http://www.jeanpratt.info/5450/ .
Подумайте: Чтобы стать успешным web-дизайнером, вы должны научиться проектировать web-сайты, верно улавливая фирменный стиль, с которым идентифицирует себя ваш клиент: механистический, цветочный, детский/игровой, классический, нью-эйдж и т.д. Как вы планируйте это делать?
ДЗ 8: Анимация в Fireworks
Вам нужен простой анимационный рисунок, но вы затрудняетесь найти его в Интернете? Тогда вы можете создать его в Fireworks, экспортировать как анимационный GIF-файл и вставить в Dreamweaver. Разница между пиксельной (например, созданной в Fireworks) и векторной  анимацией (созданной во Flash) наглядно проиллюстрирована на сайте http://xplane.com/xplanations/describe/Flashvsgif/ 
A. Создайте мерцающий анимационный объект
1. Создайте любой объект с текстом (например, кнопку с надписью или простой текстовый заголовок)

2. Сделайте дубликат этого объекта и измените цвет текста
3. Выровняйте объекты именно так, чтобы один точно повторял контуры другого (At the Top).
4. Выделите оба объекта (или столько, сколько вы продублировали для каждого из цветов)

5. Распределите объекты по кадрам
6. Установите количество повторов анимационного ролика (пощадите вашего конечного пользователя!!!)

7. Выделите кадры и установите время задержки каждого кадра на экране
8. Обрежьте холст, чтобы сделать размер рисунка величиной с область анимации
9. Экспортируйте его как анимационный GIF-файл; установите фон рисунка прозрачным
10. Импортируйте его как обыкновенный графический файл в Dreamweaver
11. Просмотрите его с помощью браузера
B. Создание простой анимации с движением по кривой
1. Откройте новое окно в Fireworks
2. Создайте на холсте объект
3. Продублируйте объект на протяжении всего пути анимации (т.е. тропинку, по которой вы хотите заставить объект перемещаться)

4. По желанию: модифицируйте разные экземпляры (instances) объектов, чтобы отразить изменения направления во время движения
5. Выделите все объекты и распределите их по кадрам
6. Далее повторите шаги 5-10 пункта “A” 


C. Создайте анимацию с векторным преобразованием объекта, например, с использованием масштабирования
1. Создайте и выделите объект
2. Конвертируйте его в символ (symbol)
3. Перетащите экземпляр (instance) этого символа на страницу
4. Измените его размер
5. Создайте промежуточные отображения (экземпляры) Modify > Symbol > Tween Instances
6. Далее повторите шаги 5-10 пункта “A”
(Поэкспериментируйте также с анимационными символами).


D. Экспортируйте все созданное вами выше на страницу Dreamweaver; ссылку на вашу страницу пришлите мне на e-mail.


Подумайте: Чем создание анимации походит на создание сценариев?
ДЗ 9: Создание масок в Fireworks
Использовать маски вам придется как в Fireworks, так и во Flash. Не смотря на кажущееся сходство, между ними есть ряд существенных различий, которые вы всегда должны иметь в виду. Диапазон возможностей работы с масками в Fireworks намного шире, т.к. Fireworks изначально является графическим редактором.
Проработайте пункты A-D, чтобы определить для себя, как наиболее эффективно использовать маскированные объекты или растровые изображения для создания графического web-сайта. После того как вы поэкспериментируйте с различными эффектами (непрозрачность, смешение, маскирование), выполните следующие пункты, переслав результаты вашей работы мне:
1. Построение одного уникального сложного объекта на основе двух простых с применением Opacity (Непрозрачности) и Blend (Смешения) (Пункт A)

2. Маскированные сгруппированные объекты и текст – поэкспериментируйте также над объектами с помощью пункта меню Effects (Эффекты) (Пункт B)

3. Маскированные растровые изображения: Group as Mask (Сгруппировать как маску), Paste as Mask (Вставить как маску), Add Mask (Добавить маску) – с использованием различных инструментов выделения (Пункт C)

4. Маскированные растровые изображения, объекты, тексты с различными краями, окантовками, текстурной или трафаретной заливкой (Пункт C)

******************************************************************************************************
A. Поэкспериментируйте с различными уровнями непрозрачности и режимами смешения
1. Создайте два объекта; позиционируйте один частично над другим
2. Выделите верхний объект; примените текстурную заливку
3. Используйте панель Layers (Слои), чтобы изменить уровень непрозрачности и режим смешения обоих объектов 


B. Поэкспериментируйте с групповыми масками
1. Создайте сложный составной объект с различными цветовыми характеристиками
2. Создайте объект маски; расположите ее поверх объектов
3. Вырежьте объект маски; сгруппируйте сложный объект, затем выполните команду Edit > Paste as Mask (Правка > Вставить как маску), чтобы вставить вырезанный объект как маску
4. Проделайте то же самое, но только используя в качестве маски текстовый объект


C. Поэкспериментируйте с маскированием растрового изображения
1. Группировать как маску: Импортируйте графическое изображение; разместите поверх него любой объект; выделите рисунок и объект, а затем сгруппируйте их как маску Modify > Mask > Group as Mask (Модифицировать > Маска > Сгруппировать как маску)
2. Вставить как маску: Импортируйте другое графическое изображение; создайте маску; сгладьте края маски; вырежьте и вставьте объект как маску
3. Добавить маску/Использовать инструменты выделения растрового изображения: Импортируйте рисунок; используйте один из инструментов выделения (marquee, oval marquee, polygon lasso), чтобы отметить область изображения, которую вы хотите сделать видимой; выберите тип края по желанию (feather, alias, hard); нажмите на значке Добавить маску (Add Mask) на панели Layers (Слои).


D. Поэкспериментируйте над масками, используя различные варианты контура и заливки
1. Задайте текстуру для объектов перед их группировкой и маскированием
2. Попробуйте задать контур другой группе объектов, но уже после их маскирования
3. Сохраните и перешлите мне результат каждого проделанного задания
a. Примечание: 
(1) Выберите опцию Show fill and stroke (Показать заливку и контур) либо опцию Grayscale appearance (Видимость по шкале полутонов) для применения текстурной/трафаретной заливки к маске
(2) Текстуры находятся в разделе «Варианты заливки» (“Fill Options”)


Примечание: помните, что маски функционируют на уровне полутонов от черного до белого, поэтому для достижения желаемого эффекта, быть может, вам понадобиться инвертировать некоторые текстурные или трафаретные заливки.
Для себя: попробуйте поэкспериментировать с различными специальными эффектами и дополнительными функциями, которые вы можете применить к растровым изображениям.
Подумайте: Откуда можно почерпнуть грандиозные дизайнерские идеи? Где, по-вашему, студенты, изучающие искусство, получают свои новые идеи? В чем еще, помимо всего прочего, можно найти источник вдохновения? 

ДЗ 10: Создание кнопок 

Fireworks позволяет создавать кнопки и редактировать их одним щелчком пальцев! Редактирование же кнопок в Dreamweaver требует гораздо большего времени (нежели в Fireworks), потому что подбирать размер вам приходится наугад. Вы можете установить первоначальное положение «вниз» (“down” state) для текущих страниц.
1. Создайте первоначальный символ кнопки (Убедитесь в том, что вы создаете его поверх знака «крестик», который является центром рабочего поля)
2. Edit > Insert > New Button (Правка > Вставить > Новая кнопка)
3. Примените различные эффекты для каждого положения (states) кнопки; измените текст и цветовую заливку
4. Поэкспериментируйте с другими специальными эффектами для кнопок (особенно со свечением (glow) и плоской тенью (drop shadow))

5. Присвойте кнопке уникальное имя
6. Оптимизируйте эту первую!


A. Создание кнопок напоминания
1. Сделайте дубликат первой кнопки (в Беблиотеке)

2. Измените текст надписи; обновите свойства каждого положения
3. Присвойте уникальное имя


B. Размещение кнопок
1. Перетащите кнопки из Библиотеки на экран
2. Разместите их соответствующим образом – следите за линиями слайса: каждое дополнительное пространство – это лишняя ячейка таблицы


C. Добавление к кнопкам всплывающего меню
1. Щелкните по вспомогательной окружности в виде прицела в центре установленной кнопки
2. Проследуйте инструкциям мастера создания всплывающего меню, чтобы определить его внешний вид и основные характеристики; соответственно настройте ссылки
3. Оговорите место расположения всплывающего меню в разделе Position (Расположение) мастера


D. Поэкспериментируйте с различными вариантами экспортирования; знайте, когда пользоваться каким
1. Images Only – рисунки должны быть вставлены на страницу в Dreamweaver по отдельности
2. HTML and Images: Selected Slices Only – должны быть вставлены как Interactive Media: Fireworks HTML
Пришлите мне по email страницу, созданную в Dreamweaver, на которую вы вставили интерактивную панель навигации Fireworks HTML

ДЗ 11: Несвязные ролловеры. 
Нарезанные страницы
Нарезка изображений на слайсы – профессиональный способ хранения файлов с оптимальным соотношением размер/качество
A. Создайте главные страницы вашего сайта в Fireworks
1. Спроектируйте страницу в Fireworks; включите ролловерные кнопки навигации
2. Экспортируйте ее корректно как HTML and Images; Откройте html-файл в Dreamweaver

B. Создайте интерактивность для каждой отдельной страницы, т.е. найдите способ привлечь пользователей
1. Создайте бессвязный ролловер
2. Экспортируйте результат по отдельности; затем импортируйте на существующую страницу в Dreamweaver
Пришлите мне по email как минимум 2 ссылки:

a. Страницу Fireworks (включающую панель навигации без всплывающего меню, заголовком, несколькими графическими объектами), которые вы, должным образом, нарезали на слайсы, оптимизировали и экспортировали
b. Страницу Dreamweaver, на которую вы вставили кадрированный, бессвязный ролловер, созданный в Fireworks
Проверка ДЗ 8-11. Экзамен по Fireworks.
Экзамен – это открытая книга или записи, 
но не открытые архивные файлы или друг!
Критерии оценки графического сайта
Введение во Flash
Памятка (по книге Кэтрин Ульрих «Macromedia Flash 5 для Windows и Macintosh») …..


1. Flash основан на «кино»-метафоре: 

a. Movie (Ролик) – это самая верхняя ступень (или уровень); он состоит из одной и более сцен (scenes). 

b. Scene (Сцена) – это вторая ступень. Если вы создаете сайт, полностью основанный на Flash, то каждая сцена будет отображать отдельную страницу вашего web-сайта. Сцена, в свою очередь, может состоять из одного и более слоев (layers). 

c. Layer (Слой) – третья ступень. В одной сцене вы можете использовать до 20-25 слоев, перед тем как у вас возникнут проблемы. В свою очередь, слой может состоять из одного и более кадров (frames)
d. Frame (Кадр) – это самая нижняя ступень; ваше содержание входит в отдельные кадры. Любое изменение содержимого (т.е. масштаба, цвета, местоположения) отражается в каждом новом кадре


2. Конечный пользователь видит все то, что вы поместили в рамки «сценического пространства» (stage). Вы можете также поместить объект вне сцены (stage), как бы предваряя его главный выход, либо позволить ему «красиво уйти за кулисы» по окончании ролика!


3. Motion tweening – перемещение объекта с одной позиции на другую или построение анимации на основе модификации символов (действует только для групп или символов)
a. Чтобы конвертировать объект в символ, достаточно выделить его и перейти в меню 
Modify > Convert to Symbol (Модифицировать > Конвертировать в символ)
b. Flash автоматически добавит ваш новый символ в библиотеку объектов, которые теперь будут доступны для вас при работе над любым роликом (movie), в случае если вы импортируйте в библиотеку текущего .fla-файла предварительно сохраненный .swf-файл: 
File > Import > Import to Library (Файл > Импортировать > Импортировать в библиотеку)


4. Shape tweening – морфинг (morphing) фигур или плавное преобразование одного изображения в другое (действует только для редактируемых фигур)
a. Чтобы конвертировать символ в редактируемый объект, достаточно выделить его и воспользоваться комбинацией клавиш [Ctrl + B] или перейти в меню Modify > Break Apart (Модифицировать > Разбить) 
Тестовые блоки разбиваются дважды: сперва на отдельные буквы, затем на пикселы
b. Flash хранит символьные объекты в библиотеке, но теперь, после разбивки, вы можете изменять форму объекта, как при работе с обыкновенной геометрической фигурой


5. Кадры хранят содержание вашего «фильма». Следует различать три основных типа кадров (с соответствующими вспомогательными клавишами для быстрой вставки)
a. Keyframe (Ключевой кадр) – [F6]: В этом кадре отражаются любые изменения объекта или символа внесенные дизайнером. При вставке ключевого кадра, Flash создает точную копию содержания предыдущего в новом ключевом кадре. Вставляйте ключевой кадр каждый раз, когда вы хотите изменить местоположение, форму или внешний вид объекта.
b. Blank keyframe (Пустой ключевой кадр) – [F7]: Ключевой кадр без содержания. Вставляйте пустые ключевые кадры в конце анимации, чтобы отобразить что-то новое.
c. Tweener frame (Кадр промежуточного преобразования) [F5]: В этом кадре отражаются любые изменения объекта или символа осуществленные программой. Flash автоматически создает кадры промежуточного преобразования между ключевыми кадрами. Вы можете конвертировать кадр промежуточного преобразования в ключевой кадр простым нажатием ПКМ на нем и выбором подпункта Convert to Keyframe (Конвертировать в ключевой кадр).


6. Рисованные объекты состоят из двух независимых компонентов: границы и заливки. Объект без границу создается простым переключением поля Stoke color (Цвет контура) в положение None (перечеркнутая ячейка политры); для создания объекта без заливки проделайте то же самое, но только в поле Fill color (Цвет заливки). Делается это до создания анимации на основе модификации символов (motion tween) или изменения формы (shape tween).


7. Flash предлагает различные варианты предварительного просмотра вашей работы:
a. Full-screen (На весь экран) [Ctrl + Enter]. Внимание! Полноэкранный предварительный просмотр создает .swf-файл, который вы можете потом вставить на страницу в Dreamweaver. Каждый последующий просмотр записывает новый файл поверх существующего без предупреждения.
b. Editing mode (Просмотр в режиме редактирования) [Enter в кадре 1]. Выделите Кадр 1 и нажмите на клавишу [Enter], чтобы просмотреть ролик один раз в режиме редактирования. Для повтора проделайте тоже самое еще раз.
c. Frame-by-frame forward and backward (Покадровое перемещение взад-вперед) [< и >]. Щелкните мышью на одном из кадров анимации. Нажмите клавишу со знаком «больше» [>] для перемещения на один кадр вправо; нажмите клавишу со знаком «меньше» [<] для перемещения на один кадр влево.
d. Browser (Просмотр с помощью браузера). Нажмите [F12] для просмотра ролика в Internet Explorer.


Подумайте: Находите ли вы возможности Flash более широкими для реализации проектов с использованием online-рекламы или корпоративного сайтостроения? Почему?
Полезные ссылки: http://www.Flashkit.com/, http://www.bestFlashanimationsite.com/ 

ДЗ 12: Анимация во Flash
Flash рабочий эталон при создании сложных анимационных роликов. Согласно последним данным 97% компьютеров на сегодняшний день поддерживают технологию Flash (т.е. они в состоянии воспроизвести вашу Flash-анимацию). Однако, не смотря на то, что теперь вы имеете возможность начинить свой ресурс «взрывной смесью», не переусердствуйте с этим. 
(См. статью Якоба Нильсена «Flash причиняет 99% неудобств» на http://www.vebius.com.ru/book/Flash.html, оригинал статьи с дополнением см. на http://www.useit.com/alertbox/20001029.html)

Примеры приведенных ниже заданий с использованием навыков работы во Flash смотрите на http://www.pcu.net/web/prattbj/wsFlash/Flashexs.htm
A. Публикация и пересылка файлов посредством FTP

1. Перейдите к пункту меню File > Publish Settings (Файл > Параметры публикации) и укажите выходные параметры

2. Нажмите кнопку Publish
3. Перепишите на сервер посредством FTP как .swf-, так и .html-файлы: оба этих файла должны быть размещены на сервере, но при ссылке достаточно указать один из них

B. Создание движения символьного объекта с промежуточными преобразованиями (motion tween)
1. Подготовьте новое «сценическое пространство» во Flash
2. Создайте объект; конвертируйте его в графический символ библиотеки
3. Включите режим Tween: Motion (Промежуточное преобразование: Модификация символов)
4. Назначьте любой кадр на временной диаграмме (Timeline) ключевым [F6]
5. Выделив финальный ключевой кадр, переместите объект в любую часть вашего «сценического пространства»


C. Изменение траектории движения символьного объекта (возможность использовать различные эффекты при желании отразить их в ходе промежуточной модификации символьного объекта, что много проще, нежели работать над каждой фазой движения в отдельности, назначая один ключевой кадр за другим)

1. Создайте простое движение символьного объекта (назначьте его начальное и конечное местоположение)

2. Назначьте какой-нибудь дополнительный эффект
3. Выделите любой промежуточный кадр анимации и сместите объект


D. Добавление специальных эффектов к символьной анимации объектов
1. Создайте объект и конвертируйте его в символ
2. Создайте движение символьного объекта (назначьте его начальное и конечное местоположение)
3. Выделите любой ключевой кадр на временной диаграмме
4. Измените свойства (brightness – «яркость», tint – «цвет», alpha – «альфа») выделенного объекта
5. Измените свойства (size – «размер», rotation – «поворот», skewness – «наклон») выделенного объекта


E. Имитация полета с вращением текста или других объектов
1. Создайте объект и конвертируйте его в символ
2. Создайте движение символьного объекта
3. Выберите направление вращения и укажите число оборотов


F. Добавление направляющей (Motion guide) для управления анимацией; задание направления с привязкой к заранее нарисованному пути
1. Создайте объект и конвертируйте его в символ
2. Создайте движение символьного объекта
3. Отметьте опции Orient to path (Ориентироваться по пути) и Snap (Привязать)
4. Добавьте элемент Motion guide (Направляющая)
5. Нарисуйте путь
6. Выделите объект в первом и последнем ключевых кадрах; прикрепите его поочередно к началу, затем к концу пути


G. Преобразование (морфинг) различных текстовых объектов и геометрических фигур друг в друга
1. Создайте или вставьте объект (текст, рисованный объект или импортированное графическое изображение)

2. Разбейте его
3. Вставьте пустой ключевой кадр где-нибудь на временной диаграмме
4. Создайте или вставьте другой объект; также разбейте его
5. Повторите для всех других фигур

Подумайте: Смогли бы вы объяснить вашему клиенту разницу между сайтом основанном на Flash и простым HTML-сайтом, и почему только один из видов может лучше всего отразить содержание и достичь поставленной цели?


ДЗ 13: Создание масок во Flash
Вообразите, что маска (mask) это конверт с окошком. Единственное, что позволяет узнать из содержания письма такой конверт (т.е. элемент маскирования), так это адрес получателя. Несмотря на то, что первоначально мы видим маску как залитый цветом объект, к концу – это всего лишь прозрачное «окошко», через которое можно обозревать только маскированную часть. Самое главное, чего не следует забывать, работая с масками, так это следить за тем, что анимированный объект на маскируемом слое полностью, без зазоров, накрывает маску с начала до конца анимационного ролика.
Используйте маски, чтобы привлечь внимание конечного пользователя и произвести впечатление, будучи ненавязчивым (какими иногда бывают Flash-анимационные ролики)

A. Создание простой маски
1. Создайте два слоя; верхний назовите “Mask” («Маска»), а нижний – “Masked” («Замаскированный») (чтобы позже вы могли их различить)

2. Создайте объект маски в первом кадре слоя “Mask” (т.е. создайте «окошко»)

3. Создайте прямоугольник с градиентной заливкой на слое “Masked” (для разнообразия, поменяйте цвета радиального градиента)

4. Задайте движение для символьного объекта с градиентной заливкой, т.е. для прямоугольника (убедитесь в том, что он накрывает «окошко» с начала до конца анимационного ролика)

5. Конвертируйте слой “Mask” в маску


B. Создание текстовой маски с окантовкой поверх радиального градиента 
(отредактируйте градиент в цветовом микшере (Color Mixer))
1. Создайте три слоя (сверху вниз): “Text Outline” («Контур текста»), “Text Mask” («Текстовая маска»), “Gradient” («Градиент»)
2. Создайте текстовый блок. Используйте широкий, крупный шрифт; толщина контура ≥2 pt., цвет темный; заливка постельного тона
3. Создайте прямоугольник с градиентной заливкой; задайте движение символьного объекта
4. Копируйте текст; вставьте его в первый кадр слоя “Text Outline”; выровняйте его точно по текстовой маске
5. Конвертируйте слой “Text Mask” в маску; закрепите и скройте слои “Text Mask” и “Gradient”
6. Разбейте текст; задайте толщину контура для символьных объектов ≥2 pt.; удалите заливку


C. Создание текстовой маски с окантовкой поверх растрового изображения
1. Создайте три слоя (сверху вниз): “Text Outline” («Контур текста»), “Text Mask” («Текстовая маска»), “Graphic” («Рисунок»)
2. Создайте текстовый блок. Используйте широкий, крупный шрифт; толщина контура ≥2 pt., цвет темный; заливка постельного тона
3. Импортируйте изображение; задайте движение символьного объекта
4. Копируйте текст; вставьте его в первый кадр слоя “Text Outline”; выровняйте его точно по текстовой маске
5. Конвертируйте слой “Text Mask” в маску; закрепите и скройте слои “Text Mask” и “Graphic”
6. Разбейте текст; задайте толщину контура для символьных объектов ≥2 pt.; удалите заливку

D. Создание двигающейся маски
1. Создайте три слоя (сверху вниз): “Moving Mask” («Двигающаяся маска»), “Visible via Mask” («Видимый через маску»), “Always Visible” («Всегда видимый»)
2. Модифицируйте в Fireworks любой графическое файл так, чтобы у вас было две версии одного и того же изображения (цветная и черно-белая)
3. Разместите на слое “Visible via Mask” рисунок, который вы хотите видеть только через маску (например, цветной)
4. Разместите на слое “Always Visible” рисунок, который вы хотите видеть всегда (например, черно-белый)
5. Создайте на слое “Moving Mask” объект маски (например, «пятно прожекторного света»); анимируйте объект; маскируйте его
6. Копируйте анимационные кадры, сделав их продолжением имеющегося движения, но с обратным ходом (reverse) (воспользуйтесь для этого контекстным меню)
Подумайте: Мы уже видели, как используются движущиеся маски для создания специальных эффектов и показа внутренней или наружной части маскированного объекта. Как еще вы бы могли эффективно использовать движущиеся маски на вашем клиентском web-сайте?
ДЗ 14: Управление несколькими слоями или сценами
У вас есть два очень простых способа сэкономить время: (1) задать эффект движение символьного объекта сразу нескольким слоям или объектам одновременно, и (2) копировать повторяющиеся элементы на различные сцены (вместо их повторного создания).

A. Воссоздайте упражнение «Игра в пинг-понг», которое вы можете найти в приложении к данному файлу с практическими заданиями, скачав их предварительно с сайта курса в разделе «Домашние задания»; добавьте звуковой эффект “Brick Drops” после каждого удара
B. Воссоздайте возрастающее/уменьшающееся пламя упражнения «Пламя» (реверсия кадров и управление несколькими слоями сэкономит ваше время!)

C. Создайте ролик “Loading” («Загрузка»); сохраните его как символ анимации (movie symbol) (воспользуйтесь инструкциями на стр. 348-349; необходимый ActionScript мы добавим позже, но вы можете закончить работу самостоятельно пользуясь описанием на стр. 402-403). Не забудьте удалить последний ключевой кадр, для сглаживания анимации, при просмотре ролика с включенным режимом автоматического повтора.
ДЗ 15: Кнопки (Buttons) и действия (Actions)
Вы можете полностью создать ваш сайт во Flash, использовать кнопки для навигации по сайту, а так же, вы наверняка определенно захотите добавить кнопку “Skip Promotion” («Пропустить заставку») в ваш Flash-ролик
A. Создание простой ролловерной кнопки
1. Создайте символ кнопки (button symbol)
2. Создайте объект для положения “Up”; центрируйте его по горизонтали и вертикали
3. Вставьте ключевой кадр для положения “Over”; измените цвет объекта; повторите для положения “Down”

4. Вставьте ключевой кадр для положения “Hit”; удалите объект; нарисуйте объект немного большего размера
5. Вставьте кнопку на сцену


B. Создание текстовой кнопки

1. Проделайте те же шаги, что и при создание ролловерной кнопки, но используя в качестве объекта только текст

2. Убедитесь, что для положения “Hit”, т.е. обозначение зоны действия, объект полностью покрывает текст

3. Вставьте кнопку на сцену и просмотрите ваш работу
C. Создание кнопки, меняющей форму в разных положениях
1. Создайте символ кнопки (button symbol)
2. Создайте совершенно разные по форме геометрические объекты для каждого из положений кнопки: “Up”, “Over”, “Down”, “Hit”
3. Вставьте кнопку на сцену и просмотрите вашу работу


D. Создание анимированной кнопки
1. Создайте три различных символа графики (graphic symbols)
2. Создайте три различных символа анимации (movie symbols), используя символы созданные вначале
3. Создайте символ кнопки (button symbol)
4. Каждый из созданных символов анимации используйте для каждого из трех положений кнопки
5. Вставьте анимированную кнопку на сцену и просмотрите вашу работу


E. Добавление звуковых эффектов к различным положениям кнопки
1. Создайте символ кнопки (button symbol)
2. Определите внешний вид для каждого из положений кнопки
3. Добавьте новый слой для звуков
4. Вставьте звук для каждого из положения кнопки (Звуковые эффекты можно загрузить с http://www.Flashkit.com либо воспользоваться звуковыми сэмплами Windows)

F. Добавление функций (action) “Start/Stop” к кнопкам и кадрам (работа с ActionScript)
1. Создайте простенький ролик
2. Создайте кнопки “Start” и “Stop”
3. Добавьте к ним функции “Play” и “Stop” соответственно
a. Не забудьте присвоить имя объекту библиотеки (т.е. кнопке), добавив к окончанию _btn
b. Не забудьте начать действие (action) с обработчика событий (on (release) {})
c. Не забудьте заключить действие в фигурные скобки {}

d. Не забудьте проверить ваш скрипит (script) перед публикацией ролика


G. Добавление функции “Go To” («Перейти») для запуска другой сцены (scene)
1. Создайте другую сцену с простым анимационным роликом
2. Добавьте функцию “Stop” к концу каждой сцены
3. Вставьте на первую и вторую сцены кнопку “Go To”, задав одноименную функцию для передвижения на сцену вперед или назад

a. Не забудьте вышеуказанные подпункты 4a-4d

b. Не забудьте указать имена сцен в скрипите в кавычках


H. Добавление функций “Stop” и “Get URL” («Поучить URL») к кадру
1. Создайте простенький ролик
2. Добавьте функцию “Stop” в конечный ключевой кадр
3. Добавьте действие “Get URL” (из панели Behaviors (Сценарии)) к конечному ключевому кадру; сделайте так, чтобы страница отображалась в том же или новом окне


ДЗ 16: Вставка звука

Звук и звуковые эффекты могут качественно усилить ваш Flash-сайт или промо-ролик. Вот несколько ресурсов, на которых вы можете найти разные звуковые сэмплы и эффекты: acidplanet.com, Flashkit.com и ZD.net
A. Общее представление
1. Способы использования звука во Flash
a. Несинхронизированный: звуки по «событию» (event) – запускаются по достижении заранее указанного фрейма и могу продолжать свое звучание даже по окончании воспроизведения ролика

b. Синхронизированный: «потоковые» (streaming) звуки – разбитые на небольшие куски и прикрепленные к конкретным фреймам так, что они синхронизируются с конкретными анимационными действиями
2. Форматы звуковых файлов, доступных для Flash
a. WAV

b. MP3

c. AIFF

3. Имейте в виду:
a. Когда вы импортируйте звуковые файлы, они автоматически помещаются в библиотеку; затем их надо поместить в вашу сцену

b. Вставить звуковые файлы можно простым перетаскиванием значка из библиотеки или выбором его из списка в поле Sound (Звук) инспектора: Свойства (Properties inspector)
c. Размещать звуковой объект следует на отдельном от действий и графики слое


B. Вставка звуковых эффектов для положений кнопки “Over” и “Down” во Flash
1. Создайте символ кнопки во Flash, выбрав внешний вид для каждого положения на свое усмотрение; обозначьте зону действия
2. Добавьте новый слой; вставьте ключевые кадры для положений “Over” и “Down”
3. Вернитесь к сцене; вставьте вашу кнопку
C. Создание индивидуально настроенного звукового объекта
1. Вставьте звуковой файл; откройте его в режиме редактирования
2. Добавьте метку-манипулятор на вспомогательной линии
3. Создайте эффект «перескакивания» звука с одного динамика на другой


D. Урезание звукового файла во Flash
1. Импортируйте любой продолжительный звуковой файл
2. Отразите соотношение времени к кадрам (time/frame length) файла
3. В режиме редактирования вставьте звуковые маркеры (volume boxes) 
Примечание: Весь файл все еще остается во Flash. Чтобы на самом деле удалить начальный и конечный фрагменты звукового файла, используйте редактор звуковых объектов.
ДЗ 17: Оптимизация и тестирование вашей анимации
Чтобы помочь вам оптимизировать медиа-файлы (звук, графика, видео), используемые в вашем ролике, во Flash встроена специальная подпрограмма Download Simulator (Симулятор загрузки).
A. Тестируйте ваш ролик

1. Перейдите в режим тестирования ([Ctrl + Enter] или Control > Test Movie (Контроль > Тестировать ролик))
2. Выберите параметры загрузки, которые, вы предполагаете, будет использовать ваша целевая аудитория (например, модем со скоростью 56,6 КБ/сек)
3. Просмотрите Bandwidth Profiler (Профайлер пропускной способности) и Streaming Graph (Диаграмму потока передачи данных)
4. Симулируйте загрузку (Download Simulator)
Примечание: Все пики, выступающие за пределы красной линии показывают задержку в загрузке. Определите причину этих пиков и попытайтесь оптимизировать (для медиа-объектов) или перераспределить (для множества ключевых кадров)

B. Вставьте ролик «Загрузка»

1. Создайте сцену (scene) «Загрузка» и расположите ее в начале ролика
2. Создайте и вставьте ролик «Загрузка» и блок динамичного текста (dynamic text box)
3. Примените следующий ActionScript к ролику «Загрузка»
onClipEvent (enterFrame) {

this._rotation += 15;

bytesLoaded = _root.getBytesLoaded();

bytesTotal = _root.getBytesTotal();

percentLoaded = Math.round(100*bytesLoaded/bytesTotal);

_root.displayText = percentLoaded + "% Loaded";

If(bytesLoaded = bytesTotal) {
gotoAndPlay("NextScene",1);

}

}

C. Публикация вашего ролика

1. Внедрить ваш ролик в существующую HTML-страницу: Insert Flash (Вставить Flash), но учтите, что на самом деле вы вставляете .swf-файл

2. Публиковать .swf-файл: перешлите посредством FTP .swf-файл на сервер, при этом адрес URL должен оканчиваться полным названием Flash-файла, оканчиивающимся расширением .swf
3. Публиковать .html-файл: перешлите на сервер посредством FTP как .swf-файл, так и .html-файл, при этом адрес URL должен оканчиваться полным названием HTML-файла, оканчивающимся расширением .html
4. Публиковать .swf-файл в окно браузера определенного размера:
a. Вставьте .swf-файл на HTML-страницу; сохраните; создайте новую HTML-страницу; примените сценарий (behavior) Open Browser Window (Открыть окно браузера) с запускающим действием onLoad; установите размер окна

или

b. Вставьте .swf-файл на HTML-страницу; вставьте следующий HTML-код (используя, конечно, размеры); сохраните
<html>

<head>

</head>

<body bgcolor=black

ONLOAD=”javascript:window.open(‘InfoAlli.html’,’info’,’height=450px,width=650px,scrollbars=no,toolbar=no,status=no,menubar=no,top=1px,resizable=no’)”>
</body>

</html>
Проверка ДЗ 12-17. Экзамен по Flash. 
Экзамен – это открытая книга или записи, 
но не открытые архивные файлы или друг!
Критерии оценки Flash промо-ролика

Регистрация вашего сайта на поисковом сервере
A. Предоставление информации для машины поиска
1. Регистрирование отличается от оптимизирования
a. Регистрирование похоже на лотерейный билет
b. Оптимизирование помогает вашему сайту войти в лучшую десятку тематических ресурсов на поисковых серверах
(1) Размещение поисковой машиной
(2) Позиционирование поисковой машиной
(3) Ранжирование (классификация) поисковой машиной
2. Понятия маркетинг и продвижение сайта посредством  поисковых систем являются различными терминами:
a. Маркетинг посредством поисковой системы
b. Продвижение посредством поисковой системы
(1) Возрастает по мере того, как сайт взаимодействует с поисковой системой так, что люди все проще могут найти вас среде Интернет


B. Бюджет для внесения информации о вашем сайте в международную поисковую систему
1. Существуют бесплатные услуги,
2. Но платные лучше
3. Плата за единовременное внесение в каталог:

a. Yahoo: $300

b. LookSmart: $150-$300

c. ИТОГО: $450-$600

4. Процесс, как правило, занимает месяц или может быть сокращен до 3-4 дней после внесения «дополнительной платы» за услуги поискового сервера, функционирующего по механизму «Червяк»:

a. Inkotomi: $30  

b. AltaVista: $40

c. ИТОГО: $70

(1) Обычно информацию необходимо обновлять каждые 6-12 месяца
5. Можно так же воспользоваться услугами платных списков (листингов)
a. GoTo (Overture): $50

b. Google: $25

c. FindWhat: $25

d. ИТОГО: $100

6. Итоговый бюджет
a. Каталоги: $450-$600

b. «Червяки»: $70

c. Платные листинги: $100

d. ИТОГО: $620-$770


C. Внесение информации о web-ресурсе в каталоги: Yahoo, LookSmart и Open Directory
1. Для чего нужно вносить информацию в каталоги?

a. Каталоги управляются людьми: ваши данные вносятся конкретным человеком
b. Их листинги могут быть просмотрены большим количеством людей
c. Поисковые машины, работающие на основе механизма «Червяк», вероятнее всего могут найти ваш сайт и добавить его в свой список (листинг) бесплатно
2. Подготовка вашего сайта для внесения в каталог
a. 25 (или менее) слов описания сайта: краткая выжимка
b. Используйте 2-3 наиболее подходящего ключевого слова, которые, по вашему мнению, будет вводить потенциальный пользователь для поиска вашего сайта
c. Выясните, какие ключевые слова используются чаще всего для поиска информации аналогичной вашей
(1) Что люди ищут (http://www.searchenginewatch.com/facts/searches.html)

(2) Jeeves: “Where can I find/Что я могу найти” была фразой №1 по частоте использования
(3) MetaCrawler/MetaSpy: ищет изолированные слова, которые меняются каждые 15 секунд
(4) Search.com Snoop: самые распространенные изолированные слова до фраз в три слова
d. Не используйте язык маркетинга
(1) Хорошо: Покупка кед, кроссовок, горных ботинок и другой обуви; попробуйте совершить бег по пересеченной местности в наших «следопытах»
(2) Плохо: Самый большой в мире обувной Интернет-магазин по лучшим ценам от самых известных производителей!!! 
3. Внесение информации в поисковую систему Yahoo: самый старый и самый лучший поисковый каталог
a. Два способа внесения информации
(1) Стандартный (бесплатно)

(a) Используется для некоммерческих категорий 

(i) Найдите синюю «инвертированную панель» вверху страницы категории
(ii) Не вносите здесь информацию коммерческого характера, потому что вас сразу дисквалифицируют
(b) Нет гарантии, что ваша информация будет просмотрена или проверенна – если это даже и произойдет, то не скоро
(c) Щелкните на “Suggest a Site/Предложить сайт” – ссылке внизу страницы Yahoo.com (вы перейдете на страницу http://docs.yahoo.com/info/suggest/)

(2) Yahoo Express (платно: $300)

(a) Без гарантии принятия – гарантируется только рассмотрение к принятию в течение 7 рабочих дней
(b) Щелкните http://add.yahoo.com/fast/add?+Business и заполните форму заявления
(c) Найдите желтую «инвертированную панель» вверху страницы категории


4. Внесение информации в систему LookSmart (дает результат при осуществлении поиска посредством MS Search программы Internet Explorer; предлагает услуги по редактированию)

a. Бесплатное внесение информации
(1) Внесение информации в http://www.zeal.com/
b. Платное внесение информации
(1) Обычный способ: $149 с 8-недельным циклом обработки (только рецензирование, с высокой вероятностью внесения)
Внесение на странице http://www.zeal.com/users/become_a_zealot.jhtml 

(2) Экспресс-способ: $300 за 2-дневный цикл обработки (только рецензирование, с высокой вероятностью внесения)
Внесение на странице http://listings.looksmart.com/ 


5. Внесение информации в каталог The Open Directory (дает результат при осуществлении поиска посредством AOL Search; предлагает услуги по редактированию введенных данных)

a. Внесение информации бесплатное, но без гарантированного цикла обработки, который, как правило, занимает около 3 недель 



D. Внесение информации о web-ресурсе в поисковые системы, основанных на механизме «Червяк»: Google, Inktomi, AltaVista, FAST, Excite
1. Поисковые машины, основанные на механизме «Червяк», на самом деле посещают web-страницы, чтобы составлять перечни (списки или листинги) web-ресурсов разбросанных в пространстве Интернет
2. Построение гиперссылок – самый лучший способ попасть в листинг бесплатно (т.е., вы делайте ссылку с вашего ресурса на внешние сайты связной тематики и просите их добавить ссылку на ваш)

3. Добавление вашего URL в Google (http://www.google.com/addURL.html)

a. Нет гарантии, что он будет включен в листинг с ссылкой Add URL/Добавить URL
b. Внесите информацию о первой (домашней) и 1-2 хороших внутренних страницах вашего сайта (на случай, если Google не сможет найти первую страницу)

c. Процесс рассмотрения занимает около месяца, и несколько быстрее при оплате
4. Добавление вашего URL в Inktomi (http://hotbot.lycos.com/addURL.asp)

a. Дает результат при осуществлении поиска посредством MS Search, AOL Search и Hotbot
b. Добавить URL через сайт Hotbot (см. URL выше)

c. Принятие (если оно происходит) занимает около месяца
d. Гарантированное принятие в двухдневный срок при выборе платной услуги внесения ($30/год/первая страница)

(1) Внесение информации через партнеров (http://www.inktomi.com/products/search/submit.html)

5. Добавление вашего URL в AltaVista (http://addURL.altavista.com/sites/addURL/newURL)

a. Этот поисковый сервер не так популярен, как в прошлом, но все еще широко применим
b. Принятие при использовании ссылки Add URL/Добавить URL не гарантированно
c. Гарантированное принятие в 1-2-недельный срок при выборе платной услуги внесения ($39/год/первая страница)
Alta Vista Express Inclusion/Экспресс-включение Alta Vista (https://www.infospider.com/av/app/)

6. Добавление вашего URL в FAST Search (http://www.alltheweb.com/add_URL.php)

a. Дает результат при осуществлении поиска посредством Lycos; имеет свою собственную поисковую машину на alltheweb.com
b. Принятие при использовании ссылки Add URL/Добавить URL не гарантированно
c. Оплата осуществляется не во время включения, а в этапах разработки 


E. Внесение информации о web-ресурсе в платные списки (листинги): Overture (GoTo), FindWhat и Google
1. Внесение информации в Overture (выкупила GoTo в октябре 2001) http://www.overture.com/  или http://www.overture.com/d/about/advertisers/
a. Поисковая машина с механизмом “Pay per click”/«Плата за клик»: ты платишь каждый раз, как только кто-либо щелкает на вашем листинге на Overture
(1) Например, введите «недвижимость», «кредитные карты», «страховка», «Бизнес-колледж»
b. Остальные могут попасть на ваш сайт через другие поисковые системы, имеющие доступ к листингам Overture
c. Оплата на Overture ($50 минимум плюс $20 за щелчки в месяц) может быть самым быстрым способом найти ваш сайт на других поисковых системах
d. Обычно хорошо пользоваться услугами Overture на начальном этапе первые пару месяцев только для того, чтобы обосноваться на других поисковых серверах, что затем позволит остальным поисковым машинам увеличить скорость загрузки 
e. Хорошо также продолжать работу с Overture при использовании слов, не имеющих высокий индекс популярности на других поисковых системах 


2. Внесение информации в FindWhat (https://secure.findwhat.com/signup/signup.asp)

a. По аналогии с Overture, но с меньшими тарифами и меньшим распространением
b. Дает результат при осуществлении поиска посредством Excite.com
c. Минимум $25 без ежемесячной абонентской платы


3. Внесение информации в Google (https://adwords.google.com/AdWords/Welcome.html)

a. Поисковая машина с механизмом “Cost per impression”/«Стоимость по впечатлению» (CPM – “cost per million”/«стоимость миллиона показов баннера») в отличие от “Pay per click”/«Плата за клик» предполагает взимание комиссии за каждое появление вашей рекламы (рекламного баннера), а не за  количество щелчков, осуществленных по ней
b. Без первоначального взноса

F. Оптимизация машиной поиска
1. «Оптимизация машиной поиска означает гарантирование того, что ваши web-страницы будут доступны для поисковых систем и сосредоточенны таким образом, что вероятность их нахождения возрастает в несколько раз».
2. «…нет никаких специальных «секретов  поисковых машин», которые бы гарантировали попадания ссылок на ваш ресурс в топ-листы. Но существует ряд незначительных изменений, которые вы можете внести для достижения больших результатов». 



G. Как работает поисковая машина
1. Два основных типа (плюс их комбинация)

a. Поисковые машины на основе механизма «Червяк» (например, HotBot)

(1) Они ползают или двигаются как пауки по сети, собирая списки (листинги)
(2) Очень важно использовать хорошие заголовки страниц и текста содержания
(3) Изменения на ваших web-страницах оказывают влияние на этот механизм – «Червяки» обычно находят ваши страницы
b. Каталоги, поддерживаемые людьми (например, Yahoo)

(1) Вы или редактор пишите описание сайта, которое вносится в поисковую систему
(2) Изменения на страницах не отражаются на каталогах
c. Гибрид поисковых машин/смешанных результатов (например, Yahoo)

(1) Основан на каталогизаторе, но так же предлагает результаты работы механизма «Червяк» (например, Google)

2. Принцип работы поисковой машины, основанной на механизме «Червяк» 
a. «Червяк» посещает web-страницу, считывает ее, а затем переходит по всем ссылкам, указанным внутри этого сайта
b. «Червяк» повторно посещает эту web-страницу через месяц, или около того, для проверки на наличие изменений
c. Результаты такого «ползанья» автоматически вводятся и обновляются в предметном указателе
d. Поисковая машина пробегает по всему предметному указателю (индексу) и ранжирует сайты по релевантности (значимости) 



H. Как поисковая машина ранжирует (классифицирует) web-страницы
1. Метод размещения/частотности
a. Ключевые слова поиска отражены в коде HTML тега заголовка
b. Ключевые слова поиска отражены на внутреннем заголовке страницы или в первых нескольких  абзацах текста
c. Ключевые слова поиска, которые появляются чаще, чем другие на странице, распознаются как более релевантные
(1) Не секрет, что не все поисковые машины используют мета-теги
(2) Размещение совершенно бесполезной информации (спама) может привести к удалению информации о вас с поискового сервера
d. Анализ ссылок – очень важная процедура. Необходимо убедиться, что вы ссылаетесь на релевантные страницы и в том, что они ссылаются на вас
e. Также важно измерение количества откликов (числа обращений к сайту). Необходимо убедиться, что вы предоставляете посетителям именно то, что они надеются найти, когда переходят на ваш сайт по ссылке, найденной через поисковую систему. Если они возвращаются на поисковый сервер и пытаются найти то, что им необходимо на другом ресурсе, то рейтинг вашего сайта может упасть 


I. Советы по размещению посредством поисковой машины
1. Подберите ваши целевые ключевые слова
a. Используйте 2 или более слова; использование одного слова повысит конкуренцию – имеет общий характер
b. Введите целевые ключевые слова для каждой страницы вашего сайта
2. Разместите ваши целевые ключевые слова
a. Поместите их в титульном заголовке (названии сайта)
b. Используйте их в главных заголовках страниц
c. Используйте их в первом абзаце основного текста
d. Предостережения
(1) Таблицы перемещают ключевые слова вниз, потому что таблица разбивает страницу, когда поисковые машины считывает ее. Решение: используйте мета-теги
(2) JavaScript, который загружается до загрузки текста HTML, перемещает ключевые слова вниз. Решение: поместить JavaScript ниже и/или использовать мета-теги
3. Включите релевантное, видимое, текстовое содержание
a. Поисковые машины не могут читать текст, представленный в виде графических объектов. Некоторые из них могут проиндексировать ваш тег альтернативного текста и мета-теги, но лучше включить видимый HTML-текст на каждую страницу.

b. Расширьте ваши текстовые ссылки включением ключевых слов в гипертекст. Например, измените слово «коллекционер» на «коллекционер, собирающий марки» или «филателист», если ваш сайт посвящен коллекционированию марок.

4. Избегайте камней преткновения поисковых машин
a. Поместите html-ссылки внизу домашней страницы, спроектированной на основе карты рисунка
b. Создайте и внесите карту сайта с активными ссылками во все основные страницы вашего сайта
c. Корректно настройте связи всех гиперссылок внутри вашего сайта так, чтобы «web-червяки» могли найти все страницы
d. Избегайте использования фреймов – поисковые машины не умеют перемещаться по фрейм-ссылкам
e. Используйте статические страницы – избегайте страниц генерируемых динамично CGI или базами данных: используйте базы данных только для обновления статических страниц – некоторые поисковые системы не в состоянии индексировать динамически созданные страницы
f. Избегайте использования символов (особенно знак вопроса «?») – они засоряют и заглушают поисковую машину
g. Используйте мета-теги, чтобы помочь поисковым системам найти ваши страницы – особенно, если они графические или основаны на фреймах
h. Стройте хорошие ссылки на другие сайты
(1) Выполните поиск по ключевым словам, по которым, вы думайте, люди могли бы разыскать ваш ресурс
(2) Свяжитесь с сайтами, которые предложила вам поисковая система в результате этого поиска, и попросите их включить (на взаимных условиях) ссылку на ваш ресурс
i. Избегайте размещения совершенно бесполезной информации (спама)
j. Внесите информацию о 2-3 страницах второго уровня, которые лучше всего описывают ваш сайт (на случай, если поисковая машина будет иметь затруднения с главной страницей); этого количества страниц будет достаточно
k. Внесите информацию о вашем сайте вручную (а не посредством автоматической программы) так, чтобы вы могли видеть, если возникнут какие-либо проблемы
l. Проверяйте ваш листинг каждые 1-2 недели, чтобы убедиться в том, что вы все еще в списке. Если нет, то внесите информацию заново.
m. Размещайте информацию о вашем сайте заново каждый раз, как только вы вносите какие-либо серьезные изменения
n. Приложите все усилия для повышения вашего рейтинга на поисковых серверах, рассмотрите другие способы увеличения роста вашей популярности в среде Интернет (см. эти советы на английском языке на сайте http://searchenginewatch.com/resources/publicity.html)


J. Как использовать HTML мета-тег
1. Описание страницы: лучше всего создать свое собственное описание, нежели позволить поисковой машине сделает это за вас. Например:
<META name="description" content="Вставьте краткое описание содержания страницы сюда.”>
2. Ключевые слова страницы: слова, которые вы хотите, чтобы поисковая машина ассоциировала с вашим сайтом.
<META name="keywords" content="ключевая фраза 1, ключевая фраза 2 и т.д.”>

3. Мета-теги особенно рекомендуется использовать на страницах с недостатком HTML-текста
4. Существует ряд проблем при использовании мета-тегов как основного инструмента для поисковых машин (см. англоязычный статью Вымерли ли поисковые машины? на http://www.wdvl.com/Internet/Dead_SearchEngines/), преимущественно имея дело со злоупотреблением спамом и врожденной неспособностью техники думать как люди (или думать вообще). 

K. Если вы очень-очень хотите использовать фреймы
1. Включите фрагмент HTML-кода для бесфреймового сайта между открывающим и закрывающим тегами <frameset>:

<frameset>

<noframes>

  <body>

     <h2>

       Это главный заголовок, который будут видеть поисковые машины.

    </h2>

       Это описание вашего сайта.

    <p>

Если вы видите этот текст, то у вашего браузера отсутствуют способности читать фреймы. Не беспокойтесь, вы все еще можете получить удовольствие от посещения нашего сайта.  Все страницы могут быть просмотрены со страницы «Содержание». Пожалуйста, заходите!
   <p>

   <a href="contents.html">Содержание</a>

    <!--это ссылка на страницу содержания набора фреймов-->

</body>

</noframes>

</frameset>

2. Убедитесь, что вы включили теги <body></body> 

3. Убедитесь, что каждая страница в наборе фреймов имеет титульный заголовок (даже в таком случае в строке заголовка браузера, на самом деле, будет отражаться только титульный заголовок страницы набора фреймов)

4. Включите ссылку «Домой» внизу всех страниц, основанных на фреймах. Убедитесь, что вы установили параметр target (цель) в положение “top” («вверху») при моделировании страницы так, чтобы люди, которые заканчивали просмотр отдельной страницы перемещались к набору фреймов. Например:
<a href="index.html" TARGET = "_top">Домой</a>




L. Поисковые системы и использование заглавных букв
Основной момент в данной ситуации это использование нижнего регистра, и тогда вы получите свыше 80% искателей. Если вы будете пытаться учесть всевозможные варианты регистров, которые могут использовать люди, то вы очень рискуете получить отказ в регистрации вашего ресурса за спам.

M. Другая полезная информация о том, как начать свое путешествие по поисковым серверам
1. Список всех главных поисковых систем: http://yaca.yandex.ru/yca/ungrp/cat/Computers/Internet/Search_Engines/
2. Список различных платных программ для поисковых машин – от баннеров до внесения информации в поисковые листинги: http://searchenginewatch.com/webmasters/paid.html (Англ.)
3. Как узнать, включен ли ваш сайт в список указателя поисковой системы: http://searchenginewatch.com/webmasters/checkURL.html (Англ.)
4. Как проверить, какие URL ссылаются на ваш ресурс: http://searchenginewatch.com/webmasters/popularity.html (Англ.)
5. Табличный список возможностей, поддерживаемых различными поисковыми машинами, основанными на механизме «Червяк»: http://searchenginewatch.com/webmasters/features.html (Англ.)
a. Он сосредоточен на четырех следующих областях
(1) Сравнивает то, как различные «червяки» ползают по вашему сайту
(2) Определяет, что именно индексируется различными «червяками»
(3) Определяет, что помогает повышать рейтинг вашего сайта (например, мета-теги, популярность ссылок) при использовании различных «червяков»
(4) Определяет, как различные «червяки» реагируют на несанкционированные попытки повысить ваш рейтинг (через спам, крошечный текст или невидимый текст)

6. Советы по тому, как децентрализовать ваш сайт и заставить поисковые системы находить его: http://searchenginewatch.com/webmasters/regional.html (Англ.)
7. Список других ресурсов о том, как оптимизировать страницы для поисковых машин: http://searchenginewatch.com/resources/design.html (Англ.)
8. Инструкции по тому, как проверить, когда «web-червяк» или «паук» посетил ваш сайт и просмотрел страницы: http://searchenginewatch.com/resources/design.html (Англ.)
Обмен данными с удаленным сервером 
посредством FTP
FTP (File Transfer Protocol – Протокол передачи файлов) это протокол, посредством которого вы можете подключиться к любому серверу по всему миру и передать файлы напрямую с вашего компьютера. Все, что вам для этого нужно это: знать адрес удаленного сервера, учетное имя пользователя, пароль и FTP-программу.
Одной из самых распространенных FTP-программ на сегодняшний день является WS_FTP. Ниже вы найдете инструкции по загрузке бесплатной программы WS_FTP, ее инсталляции и использованию. Также используйте эти рекомендации для установки вашего URL.
Загрузка WS_FTP с Интернета
1. Прейдите на сайт download.com: (http://download.cnet.com/)

2. Введите WS_FTP в поле “Search” («Поиск»).

3. [image: image5.png]WS FIPLE (3240 5.08 pick  03/14/2000
T s ave e e, oax G w2z

05: Windows SB/FB/NT 7.171 votes
File Size: B305K
License: Freeware




Выберите версию программы предлагаемую бесплатно (free) 


4. Щелкните на текстовой ссылке или кнопке Download now (Загрузить сейчас).

5. Запишите скачанный файл (ws_ftple.exe) в папку на вашем жестком диске.

6. Щелкните на кнопку Open (Открыть) в диалоговом окне загрузки (или просто перейдите в папку и двойным щелчком запустите файл ws_ftple.exe).

7. Продолжите инсталляцию согласно указаниям мастера установки.
Подключение к удаленному серверу
1. Получите от вашего Интернет-провайдера (ISP) адрес сервера, учетное имя пользователя и пароль
2. Введите всю полученную информацию в соответствующие поля диалогового окна WS_FTP. Используйте приведенную ниже иллюстрацию в качестве образца. Примечание: Опцию Save Pwd (Сохранить пароль) отмечайте лишь в том случае, если вся работа выполняется вами с персонального компьютера, а не в компьютерном классе.
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a. Profile Name (Имя профайла): введите любое имя, которое позволит вам в последующем отличать один сервер от другого
b. Host Name/Address (Имя/Адрес хоста): адрес ведущего удаленного сервера
c. Host Type (Тип хоста): Обычно назначен вариант “Automatic detect” («Определять автоматически»)
d. User ID (Идентификатор пользователя): ваше учетное имя
e. Password (Пароль): ваш пароль
f. Account (Учетная запись): игнорируйте это поле
g. Comment (Комментарии): игнорируйте это поле
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Далее у вас на экране должно появиться окно, разделенное на две части, которое выглядит приблизительно следующим образом:





4. Содержание вашей локальной системы (Local system), т.е. вашего компьютера, будет отражено слева, а удаленной системы (Remote system), т.е. удаленного сервера – справа.


5. Найдите папки и/или файлы, которые вы хотите переместить с вашего компьютера на сервер провайдера.
a. Если ваши web-файлы/папки хранятся на жестком диске, то для начала перейдите в корень вашего диска C:\, осуществив два двойных щелчка по разбитой зеленной стрелке. (На приведенном рисунке, пользователь находится на два уровня ниже относительно корневого каталога диска C:\)

b. Если ваши web-файлы/папки находятся на любом другом носителе, то откройте ниспадающее меню и выберите соответствующий диск.


6. Найдите папку на удаленном сервере и откройте ее с помощь двойного щелчка мышью, чтобы переместить туда ваши web-файлы. Примечание: Заранее узнайте у вашего провайдера о наличии папки на сервере используемой по умолчанию.


7. Перешлите всю вашу файловую структуру.
a. Одинарным щелчком выделите папку которую вы создали в Dreamweaver для сайт-проекта.

b. Отметьте опции Binary (Бинарный код) и Auto (Авто) в окне WS_FTP.

c. Кликните на кнопке со стрелкой вправо, чтобы переместить корневую папку с вашим сайтом и всеми подпапками и файлами на сервер.
Теперь, когда ваши папки находятся на сервере, все, что вам остается делать, так это перемещать отдельные доработанные или вновь созданные файлы для обновления их на сервере.


8. Пришлите новые или доработанные файлы.
a. Выделите файлы одного типа (т.е. с одним расширением, к примеру, все .html- или .jpg-файлы)
b. Выделите ASCII для .html-, .asp- или .txt-файлов.
c. Выделите Binary (Бинарный код) для любых других файлов.
d. Кликните на кнопке со стрелкой вправо, чтобы копировать файлы на сервер провайдера. 


Определение вашего URL

1. Файловая структура на сервере провайдера с вашей учетной записью должна полностью соответствовать файловой структуре вашего исходного носителя!

2. Разберитесь в своем URL. К примеру, URL http://cc.usu.edu/~jpratt/cob/index.htm может быть разбит на следующие составные части:

a. Файловый протокол и разделители.     http://
b. Имя домена (т.е. сервера, на котором размещается ваш сайт).     cc.usu.edu
c. Учетная запись пользователя (некоторые серверы требуют знак тильды «~» перед именем).    ~jpratt
d. Имя вашей корневой папки.    cob
e. Имя стартового файла.     index.htm
Обратите внимание на то, что каждый компонент URL отделен от другого левой косой чертой (/). Но учтите, что это может отличаться от сервера к серверу.
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